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Lesson Objectives

IO

Lesson 1: Getting Started
In this lesson, you will learn to create simple documents and introduces you to some file management tools
available in Words. Upon completion of this lesson, you should be able to:
identify elements on the screen



switch between documents



use the Quick Access Toolbar



save in different file formats



use the Ribbon



add document properties



work with text



close a document



move around the document



open and edit files



use Backstage to save, open, or create new



import and open PDF files

EV

AL

U



documents

R

What is Word?

FO

Word processing is a method of using a computer to create, edit and print documents such as letters, memos,
newsletters or reports. A word processing program such as Word enables you to accomplish these tasks.

The benefit of using a word processing program is that you can store the documents you create on your
computer, giving you the option to edit or enhance portions or the entire document at any time.

Word is one of the most popular word processing programs; incorporating basic word processing

functionality for preparing and editing documents and providing many features that enable you to give

documents a “professionally-published” appearance.
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Using Word enables you to focus on your content instead of on formatting as you enter the content. Word
includes a number of features to help you create professional documents:
•

a variety of illustration types such as pictures, diagrams, or shapes can be inserted into a document at
any time

a variety of formatting effects to enhance text or shapes, including Quick Styles galleries

•

use styles or templates to maintain consistent formatting in documents

•

combine or merge information together for a mass mailing

•

tools to assist in creating, modifying, or publishing documents for the Internet

N

Starting Word 2016

LY

•

To start the Word program in Windows 10, use one of the following methods:

press the WINDOWS key on the keyboard to open the Start page, click or tap

O

•

the Word 2016 tile. You will then switch to the Desktop, where Word runs;
•

N

or

click Start, scroll through the list of apps, and then click or tap Word 2016.

•

IO

You will then switch to the Desktop, where Word runs; or

on the Desktop, click the Word 2016 Quick Launch icon in the taskbar.

AT

Looking at the Screen

FO

R

EV

AL

U

When Word starts, it displays a screen similar to the following Backstage view:

At this point, you can choose to create a new blank document, create a new document using an existing
design or template, or open a file from a specific location (discussed a bit later in this lesson). For the purpose
of viewing the Word screen, we will create a new blank document.

2
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Quick Access Toolbar

Ribbon Tabs

Title Bar

Min/Restore/Max/Close

Tell Me

LY

File Tab

N

O

N

Insertion Point

View
Buttons

Zoom
Slider

Zoom
Level

IO

Status Bar

File Tab – Click this tab to open the Backstage view to manage files.

AT

Quick Access Toolbar – Gain quick access to frequently used commands.

Title Bar – Indicates which file and program is currently displayed in the window.
Minimize/Maximize/Restore Down/Close – Affect how much of the application window displays on the

U

screen.

Ribbon Tabs – Click a tab to access commands to complete a specific type of task.

AL

Tell Me – A Help option where you can type keywords about a particular type of task and view information

from the Word Help system on how to complete that task.

Insertion Point – The flashing bar on the screen that indicates your current position in the document;

EV

commonly referred to as the cursor.

Status Bar – Find information about the document currently displayed, such as which page you are viewing,
or the total number of pages, or whether an error condition exists.

View Buttons – Click to quickly change between the different document views available in the application.

R

Zoom Slider – Click the buttons to zoom in or out in increments of 10%, or drag the slider button to a

specific zoom percentage.

FO

Zoom Level – Click this button to display a window for various percentages to zoom in or out of the
document, including how to display multiple pages.

The previous screen displays commonly used areas of the Word screen. As you can customize the screen’s

appearance, not all parts always appear. For instance, you can choose to turn the ruler on, that is for precise

alignment of financial reports. You can also set up defaults, such as the font or the margins, for each new
document.
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Accessing Commands and Features
Objective 1.4.3
Many features and conventions shown here in Word are consistent across all programs in the Office suite.

You can choose to show or hide a number of the elements shown in this section. In most cases, set items by

clicking the File tab, clicking Options and then clicking the General category.

LY

Using ScreenTips

Use ScreenTips to help identify buttons or elements on the tabs of the Ribbon and the screen. To view a

ScreenTip, position the mouse cursor on the item. A tip then displays the name of the button along with a

N

description of its purpose. For some items, a keyboard shortcut may also display as an alternative for

Using the Quick Access Toolbar

IO

N

O

activating this feature.

AT

The Quick Access Toolbar, at the left of the title bar above the Ribbon, contains buttons for frequently used

commands. By default, this toolbar contains the Word control icon, Save, Undo, Redo and Customize Quick

Access Toolbar buttons. Use the last button to customize or display those commands you use frequently,

U

such as new blank document, print, or spell check.

Note: Depending on the configuration of the computing device or if other people use this device, you may

AL

have different buttons on the Quick Access Toolbar, such as a button for touch screen or the Print button.
Repeat/
Redo

EV

Save

Undo

Customize Quick
Access Toolbar

R

To move the Quick Access Toolbar to below the Ribbon:
click Customize Quick Access Toolbar and then click Show Below the Ribbon; or

•

right-click the Ribbon and then click Show Quick Access Toolbar Below the Ribbon.

FO

•

4
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You can customize the Quick Access Toolbar to contain commands you use frequently. Click Customize

N

O

N

LY

Quick Access Toolbar to display a list of other commonly used commands:

FO

R

EV

AL

U

AT

IO

If the command you would like to add to the Quick Access Toolbar is not listed here, click More Commands.

Use the scroll bar to find the command you want in the list of commands for the Popular Commands choice.
Click to select the command and then click Add (or Remove) to include it in the Quick Access Toolbar list at
the right. You can then use the Up or Down arrows to rearrange the order of the buttons on the toolbar.
Click OK when finished customizing the Quick Access Toolbar.
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Using the Ribbon

The Ribbon can help you quickly find the commands you require. Commands are grouped on tabs with each

tab relating to a type of activity, such as inserting items into a document, changing the view of your
document, or formatting text in the document. You can customize the Ribbon to display those commands
you use frequently in a particular order, or to add or remove commands for a Ribbon tab.

Note: Depending on the computing device, you may see additional tabs as with the following which

N

LY

includes the Draw tab based on the fact that this computing device has touch screen capability.

O

To reduce screen clutter, contextual tabs appear only when they are applicable, for example, Picture Tools,

•

IO

N

Header and Footer Tools, Table Tools.

Each tab on the Ribbon contains groups with similar commands, for example, the Home tab has a group

AT

called Font that contains buttons for formatting text characters; the Insert tab contains a group with
different types of graphics or illustrations that can be inserted into a document.

•

A button that appears in a different background color or has an outline is active; many of these deactivate when you click the same button or click another choice. For instance, the Bold command can be

U

applied to selected text by clicking that button; to turn off the boldface, click the same button again. If
you want the text to be larger, click the down arrow for the Size button and choose the required size.

•

AL

When you need to change the font size again, click the down arrow for Size and then select the new size.
If a group shows a feature with a scroll bar, it also has a button below the bottom scroll button that you
can click to display the full list or gallery for that option.
When you click the

(More) button, the gallery

EV

–

displays more options as seen in the following

image. As you point the mouse cursor at an
option, Word displays a Live Preview showing

R

how the selected item will appear if you apply

FO

this feature. You can turn off this feature in the

6

Word Options.
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In a feature where you have a gallery of options, Word shows the current selection with a thick

•

Click the

LY

outline whereas the Live Preview shows a thin border.

button at the lower right of a group to show a corresponding dialog box, window, or task

pane with more options for this feature. Task panes appear at the left or right side of the screen. This

AL

U

AT

IO

N

O

N

button displays the name of the item that appears when you click the button.

Dialog Box

Window/Task Pane

With the dialog box, you can select items from the lists, use the arrow for a list box to display more choices
for that list, or click a command to turn the feature on or off. It may display a preview of the changes.

EV

A task pane usually contains options specific to the feature as seen in the preceding graphic that focuses on
the styles currently available. Another task pane is the Office Clipboard that displays any item that has been
cut or copied.

R

The Ribbon can be collapsed or minimized if you want to show more of your document or you do not want
to display the Ribbon. To collapse the Ribbon:
click the

•

double-click any Ribbon tab, or

•

right-click anywhere on the Ribbon and then click Collapse the Ribbon, or

•

press CTRL+F1.

FO

•

button at the far right of the top of the Ribbon, or

To show the Ribbon again, repeat any of the previous steps used to collapse the Ribbon.
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(Ribbon Options) button for methods to display or hide the Ribbon:

LY

You can also click the

You can access the Ribbon using the keyboard; some users consider the keyboard a faster method for
accessing commands. There is also consistency between Windows programs as some keyboard shortcuts are

N

the same, such as pressing CTRL+C to copy, CTRL+S to save, or CTRL+P to print.

To access the Ribbon using the keyboard, press ALT or F10 to display the keyboard buttons for the commands

IO

N

O

in the Ribbon.

AT

Then press the corresponding letter for the item you want to access.

To exit or cancel a selection at any time, press ESC. You may need to press ESC more than once to return to
your document.

U

Using the Backstage

AL

When you click the File tab, Word displays the Backstage view for you to select a command to manage your

files. This view is available for all the Office programs, setting a consistent look and location for users to use
when they want to manage their files.

EV

You use this startup screen to indicate the type of document you want to work with. You can choose to create
a blank new document (or workbook, or presentation) by clicking the first template listed in the gallery or
you can click one of the other templates to create a document that includes pre-configured elements.

You can access the other elements of the Backstage view from the startup screen by clicking the Open Other

R

Documents link.

Use the Backstage view to create, open, save, print and manage your files. The commands and options

FO

available here are related to things you can do with the entire file itself. For example, you can display
information about the file, create a new file or open an existing file, assign a password, save a file with a

different name, print or share the file with others.

You access the appropriate commands on the various tabs of the Backstage view. These tabs are: Info, New,
Open, Save, Save As, History, Print, Share, Export, Close and Account. The New tab is the startup screen.

When you want to exit Backstage view and return to editing your document, click the
corner.

8

at the top left
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Learn to customize the Quick Access Toolbar
In this exercise you will customize the Quick Access Toolbar to help you manage documents.
1

Start Word, if not already active. Click File, click New and click Blank document to create a new blank

document.

On the Quick Access Toolbar, click the Customize Quick Access Toolbar button and click New.

3

Click the Customize Quick Access Toolbar button and click Quick Print.

4

Click the Customize Quick Access Toolbar button and click More Commands.

5

In the list box at the right, click New File and click the Move Up button to position this command above

6

Click OK to exit the Customize Quick Access Toolbar dialog box.

O

N

LY

2

N

Save.

IO

The Quick Access Toolbar should show the New File button at the left side.
7

Click the New button just added to the Quick Access toolbar to see if Word creates a new blank

8

Click the Customize Quick Access Toolbar button and click Quick Print to remove this button from the

AT

toolbar.

Click the Customize Quick Access Toolbar button and click New to remove this button from the
toolbar.

U

9

document for you.

AL

Working with Text

Typing (keyboarding) involves using the keyboard to input text into the document displayed on the screen.

Editing involves performing such tasks as inserting and deleting single characters, words or multiple lines of

EV

text, as well as inserting and deleting blank lines between paragraphs. The following are the basic concepts
of typing and editing text in Word:

Insertion Point – The vertical blinking bar on the screen shows where you currently are in the document; it

moves to the right as you type new text. This bar is also called the I-beam or cursor.

R

Deleting Text – To delete a character to the right of the insertion point, press DELETE. To delete a character

to the left of the insertion point, press BACKSPACE.

FO

Word Wrap – When you have typed enough words to fill a line, the next word automatically wraps to the

next line. Press ENTER at the end of each paragraph of text.

Blank Lines – A blank line is a paragraph with no text. To insert a blank line, press ENTER. This places a
paragraph mark (¶) into the document and adds space between paragraphs. To remove a blank line, move
to the paragraph mark and delete it as if it were a text character.
Note: The paragraph mark (¶) will only appear when
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Moving Around in the Document
The insertion point indicates the location where Word will insert new text or pasted items. You can use either
the mouse or the keyboard to navigate around a document.

To use the mouse to move the insertion point to a new location in the document, point and click at the
Listed below are some keyboard methods to move quickly in a document.

LY

desired new location.

Press

Desired Movement

Press

Next character

RIGHT arrow

Next line

DOWN

Previous character

LEFT arrow

Previous line

UP

Next word

CTRL+RIGHT

Next paragraph

Previous word

CTRL+LEFT

Previous paragraph

N

Desired Movement

CTRL+DOWN

O

CTRL+UP

HOME

Next screen

END

Previous screen

PGUP

Beginning of document

CTRL+HOME

Next page

CTRL+PGDN

End of document

CTRL+END

Previous page

CTRL+PGUP

Go to page

CTRL+G or F5

IO

•

PGDN

N

Beginning of line
End of line

When you have a multiple page document, use the vertical scroll bar to move or scroll the view of the
screen through the document from top to bottom and vice versa.

When the document is wider than the screen displays, use the horizontal scroll bar to move or scroll the

AT

•

view from side-to-side, across the document.

When you drag the scroll box along the vertical scroll bar, a ScreenTip displays your position in the
document, similar to

document is set up.

. This may be a page number or heading text, depending on how your

U

•

You can also use the wheel on the mouse to move up or down in the document.

•

You can use the previously listed navigation tools to move left or right by one or more words. This applies

AL

•

to any keyboard options when moving around a document.

EV

Learn to enter text

In this exercise, you will create a new document and type some simple text, using word wrap to determine
how many words will fit on each line. You will also learn how to end a paragraph of text.

In the blank document on your screen, type: You as a Volunteer and then press ENTER twice.

R

1

FO

Notice how Word allows you to enter text directly onto the screen and, when you press ENTER, the cursor
moves to the beginning of the next line. When you press ENTER a second time, you create a blank line.

10
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